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Introduction
Thank you for choosing SMART Estimator.
SMART Estimator Quote IT is a highly customisable document creator. Information about your
scaffolding is automatically shown in the quote.

Text and wording can be easily customised. The layout, images and fonts can be set to match your
company branding.
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Print a quotation
When you first open the Quote IT tab, you will see that a basic quotation document has been created
for you. It shows details about this project, and (if applicable) details of the item which is active in the
project browser.

To print your quotation, click the Print Preview button in the toolbar:
You will see that all of the sections in this quotation have been placed in order. Some of
the sections have been repeated, because they have information about items. Other
sections have not been repeated, because they only have information about the project.
A new toolbar is displayed while previewing a quotation:

Feature

Description

Print Preview

Closes the preview of the quotation and returns to the quotation editor.

Set Email Text

Options for setting the text shown when using the Email As option.

Print

Prints the report, providing options to select the required printer and paper options.

Quick Print

Prints the report to the default printer.

Page Setup

Allows you to choose the paper size, margins, and orientation: portrait or landscape.

Navigation

Provides options to move back and forth through the pages of the report.

Zoom

Zooms the report to allow you to see it in detail or to view multiple pages.

Page Colour

Allows you to specify the background colour to use while printing, for example if your
company uses a coloured background on its stationery.

Export to

Allows you to export the quote to an Adobe PDF or a Microsoft Word document.

Email as

Allows you to create an email with the quotation attached as an Adobe PDF or
Microsoft Word document.

To close the preview and return, just press the Print Preview button again.
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Email a quotation
Creating an email with your quotation attached is discussed in the Print a quotation section, above.
It is possible to customise the text that will appear in your email by default. To do this, from the main
quotation view, select the Set Email Text button.

Change the text in this box and press OK to apply your changes. You can even include Project
SMARTText and images in your email text.

To save this text for future projects, use the OK button.
To go back to the last saved version of this text, use the Cancel button.
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Customise your quote
You will probably want to replace the SMART Estimator quotation with one customised for your
business. There are two types of customisation for you to consider:
 Customise the quotation template;
This means permanently changing the way the quotation looks to suit your business.
You can, for example, add your company logo and update the wording shown on the covering
letter.
Please see the Create your own quote template section for details of how to do this.
 Change the wording on a single quote.
Adjusting the wording on a single quote is straightforward.
Please see the Edit a single quotation section for details of how to do this.
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Create your own quote template
Note on saving
You may have multiple quotation templates. By default there are two, called “Full Quotation” and
“Summary Quotation”.
When you save a project as a SMART Estimator (.mIT) file (or to your Enterprise Server) not all
quotation templates are saved to the file. Quotation templates are saved to the file using the following
logic:
 If you have viewed or edited a template since you started this estimate, it is saved.
 If this project already included some templates when you opened it (and you haven’t deleted
them) those templates are saved.
 If you haven’t viewed any templates, the first one in the list is saved.

Create your own quote template
Before you start editing quotes and changing the way the quote looks, we would advise you to create
new templates based on the templates supplied with the software. These templates are stored inside
a folder named My Quotes (or Shared Quotes).
If you have been sent a quotation template (.mITq) file, please skip to the Import or export a quote
template section.

Editing tools
It is possible to edit the document without using text editing tool buttons. For example, if you
highlight some of the text and press the Ctrl and the B key together, the text will become bold.
However, it is much easier to make changes to the document using the text editing tools. To
show these tools, select the Text Editing Tools button in the main toolbar.

You will notice that some new buttons appear in the main toolbar. Also, a new toolbar appears
above the section document.
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Copy an existing quote to create your own template
Open a template that you would like to copy by selecting it from the Select Quote drop-down menu.

For the purposes of this example we are going to copy the “Full Quotation”.

Now open the template editing view by selecting the Edit this Quote Template button.

My Quotes / Shared Quotes
There is a special folder called My Quotes. If you have the network version, and are connected to
the Enterprise Server, this folder is called Shared Quotes. The Shared Quotes folder is shared by
everyone on your network. All of your quotation documents are stored in this folder.
It is possible to save and delete quotes from My Quotes / Shared Quotes.

To create a copy of this Quote, including all of its section templates, select the Save to My Quotes (or
Save to Shared Quotes) button.
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At the bottom of the drop-down menu, click in the New text box and type a name for your new Quote,
such as “Your Company Name Full Quotation”, i.e. “CADS Full Quotation”.
Click on Save to create the copy of the template.

You can check that you have successfully created a copy. Simply select the Save to My Quotes (or
Save to Shared Quotes) button again and you can see a new quote with the name that you selected.

Also if you select the Delete from My Quotes (or Delete from Shared Quotes) button, you will also
see the Quote that you have created. At this point you can delete unwanted quote templates.
It might be helpful to keep the original “Full Quotation” until you are finished with your new quote.
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To finish copying, close the Edit this Quote Template command by clicking the button again.

Next you are going to select your new template so you can change it.
If you now pick Select Quote, you can see the quote templates available for use.

Select the template you created from the list. In this example, it is called “CADS Full Quotation”.
Please note that you should save regularly whilst creating your template.
If you make a mistake it is often easier to close the Edit this Quote Template and start again with the
particular step that you were attempting.
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Adding headers and footers to your template
When you first open the quote in the Edit Quote Template command you will notice that it has generic
text, logos, headers and footers.

The first step is to edit the header of the covering letter.
If you would like to add a logo to your header or footer please ensure that you know its location on
your hard disk. The following file formats are supported:








BMP
JPG
PNG
GIF
TIF
EMF
WMF

Bitmap
JPEG
Portable Network Graphics
Graphics Interchange
Tagged Image File
Microsoft Enhanced Metafile
Windows Metafile

Now in Quote IT select the Edit This Quote Template button.

Please Note: If you DO NOT select the Edit This Quote Template button any changes that you make
will only affect the current project. It will not be possible to save the changes you have made for future
projects.
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Select the covering letter
Navigating a quotation
Every quote is divided into one or more sections. A section might appear only once, or it might be
repeated for every item in the project.
The active quote section is shown as the document in the middle of the screen.

If the quotation has three or less sections, a button is shown for each.
If there are four or more, a single menu is shown instead.
You can show different sections by selecting them from the toolbar.

Make sure that the Covering Letter section is selected, it will be highlighted as shown below.
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Select the header
To activate the header area of the template double click with your left mouse button in the area above
the customer address field. You will know that the header area is active as the text becomes darker
and the header tab is visible.
You can also use the Insert > Header button to select the header.

Replace the company logo
Select the default logo image (which includes the text “Your logo here”).

Press the Delete key to remove it.
Click on the Inline Picture button on the Insert Tab of the Text Editing Toolbar.
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Browse to the folder where your logo file is located, select it and click Open.

The logo will be inserted in the header area but it may not be the correct size.

Left click on your new logo.
To resize the logo, left mouse click on the resize circle on the bottom right of the logo. Move the mouse
to the right to resize the logo to fit into the header area. If you hold the Ctrl key down on the keyboard
whilst you are resizing this will maintain the logo’s aspect ratio and prevents the logo stretching
unevenly.

This ends the section on adding your company logo to the header.
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Adding the footer logos
You may wish to add industry compliant logos to your footer as well as your company registration
number etc.
In this example we are going to add logos and text.
Scroll down to the bottom of the Covering Page, double left mouse click in the Footer area.
The Edit this Quote Template, Covering Letter and Text Editing Tools buttons should still be selected.

Adding space for more logos
The default footer includes a table with some text and a logo in it. To see the gridlines of the table,
select the View Gridlines button from the Table Tools > Layout tab on the text editing toolbar:

The right column is only large enough for one image.

To increase the size of the right column, grab the column grip and drag it to the left.

Next, replace the “Your slogan here…” text with whatever text you prefer. Perhaps type in your email
and company registration number, or your company slogan.
The Home Tab on the text editing toolbar has options for setting the text font, height, colour etc.

Now you are going to insert your industry logos. These can be inserted and resized individually to meet
your requirements. Remember when resizing the logo, hold the Ctrl key down on the keyboard to
maintain the logo’s aspect ratio (to keep it the same height to width ratio).
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To add the first logo, select the existing “Your associations here” logo and press the Delete key to
remove it.

Select the Insert Tab on the Text Editing Toolbar and click on Inline Picture.

Browse to the folder where your footer logos are located, click on the logo and select Open. The logo
will be inserted in the footer area but it may not be in the correct position or be the correct size.
Select the logo with the left mouse button, resize and move as required (as described in the Adding
your company logo to the header section, above).
Once this has been completed, save your template. In this example the template is called “CADS Full
Quotation”.

Make sure that you save first before previewing the quote!
To make sure that this now prints as desired, first deselect the Edit this Quote Template button.
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Now select the Print Preview button.

You can now see the changes that we have made, as they will appear on the printout.
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Click the Print Preview button again to close.

Repeating a header on every page
To repeat a header on every page, copy the header from the Covering Letter section to each of the
other sections.
Don’t forget to use Edit this quote template mode on each section, and to save your changes.

Set your signature graphic
You can add a digital signature to your covering letter template and type in the estimator’s name. You
will first need to scan and save your signature to your hard disk. The same graphical file formats apply
as in the header and footers above.
To do this, make sure you have selected the Covering Letter and Edit this Quote Template buttons.

Click on the signature image below “Yours Faithfully,”

In the Explorer Window browse to the folder where your logo file is located, select it and click Open.

The signature image is inserted into the quotation. This graphic will be used for all future quotes you
print.
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This concludes the section on setting a signature for your quote.

Changing text within the covering letter
You have changed the header, footer and signature on your covering letter. Now let’s take a look at
changing the text in the main body of the letter.

As you can see the letter is in its standard “out of the box” format. Before we can change the text we
need to be back in the editing mode. To do this, select the Edit this Quote Template button.

For this example we are only going to show the total price of the contract and not the weekly hire or
extra hire fees.
To do this, highlight the sections to be removed and hit the Delete key on the keyboard.
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Repeat this to remove all the unwanted wording.

Now save your updated quote template.

Press the Print Preview button.
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And now you will see your updated covering letter.
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Changing text within the item description
Within our example, we are going to add a new paragraph entitled “Discount”. This will show how
much discount has been applied to the price.
To do this close your print preview from before, by deselecting the Print Preview button.

Change to the Item Description Section.

Now make sure the Edit this Quote Template button is deselected.
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You can now see how the items will look in the quotation.

Select the Edit this Quote Template button to change back to the template view.
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Normal Text versus SMARTText
There are two types of text:
 Normal Text
Most of the document is made up of normal text. To change this text, simply select it and type to
replace it.
 SMARTText
Some of the document is made up of SMARTText. SMARTText is created by taking information
from the project browser and other parts of the software. These chunks of text will automatically
update to match the rest of the software.
For example, if you add an item to the project, SMARTText for the new item will be created.

Types of SMARTText
There are two types of SMARTText:
 Item SMARTText
Item SMARTText shows information about a specific item in the project. For instance, it might
show the item’s name, or some information about the pricing for that one item.

 Other SMARTText
Other SMARTText includes any information which is not specific to a single item. For example, the
Contract Number as shown in the Project Browser.
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You can now see how the item breakdown is split up using Normal text and SMARTText.
Normal Text

SMARTText

We want to add an extra paragraph to the quote comprising of a “Discount” header text and some
text showing how much discount has been applied.
For this example you need to select a new row at the end of the item description.
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With the text editing toolbar, set your text to Arial, the size to 11, and make it bold.

Now enter your new header, Discount.

Press Enter to move to the next line. (This way our next changes do not effect the “Discount” line.)
Deselect the Bold text button.

At the top of your screen next to the Text Editing Tools button, you will see another button called
Insert SMARTText.

Here you can see the two types of SMARTText:

There is Project SMARTText. This is SMARTText which is not specifically related to any item.
There is also Item SMARTText. This holds information which changes as you make changes to a project
item.
To add the “Discount Details” we will be using a combination of Normal text and Item SMARTText.
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So type the following line of text using Normal text, beneath the heading “Discount”:
“A discount of”

Now using Insert Item SMARTText, add in the Discount Total.
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And finally add “ has already been applied to this price.” to the end of the line in Normal text.

Now save your updated quote template.

Then deselect the Edit this Quote Template button.

You can see how this new text displays with the SMARTText.
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Changing the active item
The document only shows item specific SMARTText for the active item. You can change the active
item in the Project Browser by clicking on an item.

Here, Item 2 is active. (It is outlined in green).
I can activate Item 1 instead by clicking on it.

When you change the active item, any item-specific information will change to match.
In fact, every version of this section document is different. If you make changes while Item 1 is active,
it will not affect the document which is shown for Item 2. If you want to make changes which affect
the document for every item in the project, see the Edit a Section Template section.
Please note, any changes that you make to a specific item cannot be saved and used
for future projects.
Future projects will not contain this specific item (even if they have a similar one),
so any changes you make here will only affect this section document, in this project.

It is a good idea to change the Section Templates before you make any item-specific
changes. To find out how, see the Edit a Section Template section below.
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Adding and removing sections
If you don’t want to keep the default sections in your quote, or if you want to add new sections to
your quote, you can do this by using the Add Section and Delete Section buttons.

Add a new section
Before clearing out all of the sections that you don’t want, you need to create at least one new section.
To do this, click on the Add Section (“S+”) button in the Sections part of the toolbar.

You will be prompted to give the section a name. Choose one and type it in.

Why not delete the sections that I don’t want first?
A Quote template cannot have less than one section. If you want to delete all of the sections in a
template, you need to add at least one replacement first.

Delete any sections that you don’t want
Any sections that are not required can be erased by selecting them from the Delete Section dropdown.
When you have only one section left, this button will disappear, because every quote must have at
least one section. (To delete the last section, you must first add a replacement. See Add a new
Section, above.)

Change the order of sections

Press the Swap with Previous or Swap with Next buttons to change the position of the active section.
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Section configuration
The Begin Section and Repeat Section buttons are used to set whether this section is printed on a
new page or not.

Begin section
This option affects every section after the first (i.e. “Covering Letter”). If the first option is set, this
section will start on a new page. If the second option is set, this section will continue on the same
page as the section before it.

Repeat section
This option only affects sections which have item specific information in. For us, that means it only
affects the Item Description section. In the Print Preview, such sections repeat once for every item in
the project.
If the first option is set, every repeat will start on a new page. If the second option is set, every repeat
will continue on the same page.
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Import or export a quote template
How to import a quotation template
If you have been provided with a quotation template (.mITq) file by CADS or a colleague, you can easily
import it into SMART Estimator. If you received the file via email, please save it to a convenient
location. Make sure you know how to find it.
Press the Import Quote button.

Select the quotation template file and select Open.

If you receive the following message, select Yes.

You have now successfully imported the quotation template file.
To switch to your new quotation template simply select it from the Select Quote menu.
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How to export a quotation template
To export a quotation template, so you can share it as a file, select your quote from the Export Quote
menu.

You can now choose a suitably convenient place to save the exported quotation template.

Remember where you saved your template.
The exported quotation template file can now be easily transferred to another user or workstation via
email or file transfer.
If you are using the SMART Estimator Enterprise module, your quote templates will automatically be
available to everyone connected to your server, so there is no need to export your template.
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Edit a single quotation
When you have customised your quotation template, SMART Estimator will automatically set the
majority of the quotation text correctly for you. However, you may wish to change the text for a single
quote to account for special conditions or extra descriptions.

Editing tools
It is possible to edit the document without using text editing tool buttons. For example, if you
highlight some of the text and press the Ctrl and the B key together, the text will become bold.
However, it is much easier to make changes to the document using the text editing tools. To
show these tools, select the Text Editing Tools button in the main toolbar.

You will notice that some new buttons appear in the main toolbar. Also, a new toolbar appears
above the section document.

Editing the quotation text
Most text of the quotation can be typed over as you would in any other word processor. Some special
SMARTText is created automatically by SMART Estimator. There are a few ways for you to change the
wording of a block of SMARTText.

Editing SMARTText
There are two types of SMARTText:
 Editable SMARTText
 Non-editable SMARTText
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Editable SMARTText
Some SMARTText can be edited using special tools. To access these tools, select one piece of
SMARTText. The easiest way to do this is by just clicking on it once. The whole of the SMARTText will
be selected. If you select more than a single piece of SMARTText, (even if you have only selected the
text and an extra space), the tools will not appear.
For example, clicking on the Scaffold Dimensions SMARTText reveals this:

Try it!
Select the Include Elevation Height checkbox and press the green tick to add some extra detail
to your quotation.

Non-editable SMARTText
Most SMARTText is not editable. This can only be changed by erasing it and typing some other text,
or by “exploding” it. See the next section for details.

Exploding SMARTText
All SMARTText includes an option to convert it to basic text. Click on the SMARTText to show the
Convert to basic text button:
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Changing SMARTText into basic text means that changes made in other parts of the software will no
longer affect this text.
For example, if I delete the item tendered price SMARTText and replaced it with “£1000”, any changes
that I make to the item’s pricing will not change the £1000 value. The text is now fixed to “£1000”
unless I type over it again.

34

Copyright 2020 © Computer and Design Services Limited

Quote IT user guide

Edit the clauses and conditions
A list of clauses (sometimes known as conditions or qualifications) can be added to every quote. It is
also possible to set clauses for individual items within the quotation.
Clauses are specific blocks of text that are placed automatically within the quote, which can be easily
added or removed:

There are a set of tools available to make adding and removing clauses from the quotation as easy as
possible. To access these tools, simply click on the Clauses SMARTText or on the Terms and
Conditions SMARTText. A box will appear with some tools:
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Clauses versus conditions
SMART Estimator Quote IT differentiates between “clauses” and “conditions”.
 Clauses
Clauses are associated with a single item in the project. They may be different for every
project item. Clauses appear in the Clauses SMARTText.
 Conditions
Conditions added to the project itself. These are usually standard blocks of text which are
added to every quotation. Conditions appear in the Terms and Conditions SMARTText.

Add or remove a clause from the quotation
To add a clause to the quotation, simply check the Select box for that clause:

Check the select box to add a clause to the quotation.

To remove a clause, simply deselect the box.
Note: To save changes to the Select column for:
 this project, use the green tick (Accept and Close) button;
 future projects, please see the Change the advanced clause settings section instead.
The clause Name is provided to make clauses easier to locate in the list. The name does not appear
in the quotation.
Personalising the clause Names can make it easier to find clauses in the future.

Save your changes by pressing the Save these Settings to All Templates button. This will store your
changes for future projects. If this button is hidden, press the All Clauses or All Conditions button to
show it.
Note: This does NOT save changes to the Select column.
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Edit clause text
To change the text which appears in the quotation for a clause, change the Description text:

Edit a clause Description to change the text which appears in the quotation when this clause is selected.

Save your changes by pressing the Save these Settings to All Templates button. This will store your
changes for future projects. If this button is hidden, press the All Clauses or All Conditions button to
show it.

Add a clause to the list
At the bottom of the Project Conditions configuration page there is a section named Add to Group.

Within the Add New Clause section, click your mouse in the second column from the left, named Add
to Group.
IMPORTANT: If you are adding new conditions to an existing group you must type the exact
name of the group into this box. If you type something different, the Project Conditions tool
will automatically create a new group with the name that you entered.
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Now click in the next column on the right. In this box you can enter a Name for your clause, to make
it easier to find.

Press the Tab key again on your keyboard, this will move your cursor across to the next column on the
right. In this box you can enter a Description. This is the text which will appear on the quote.

Press the Add button to add this clause to your list.

This clause is now available for this quotation only. To make it available for future projects, select
the Save these Settings to All Templates button.
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Change the clauses view
There are three viewing options for clauses:
 All Clauses (or All Conditions)
 Clauses Selected for this Item (or Conditions Selected for this Project)
 Recommended Clauses (or Recommended Conditions)
All Clauses is the basic view, showing every clause, whether it is selected or not.
Clauses Selected for this item will only show clauses which have been selected, so they will appear in
the quotation.
Recommended Clauses is empty by default. It includes clauses which SMART Estimator Quote IT does
not automatically select for you, but which are marked as recommended for a particular item or
project.

Save changes to the clauses
You can save your changes to the clause names, description and advanced settings (see below) by
pressing the Save these Settings to All Templates button. To change only the clause selection, choose
the Accept and Close button instead:
Save these changes to All Templates stores the text changes to individual clauses.

Accept and Close applies the clauses you selected.

39

Copyright 2020 © Computer and Design Services Limited

Quote IT user guide

Change the advanced clause settings
SMART Estimator Quote IT provides some powerful tools for automatically adding and recommending
clauses and conditions for every project.
To access these settings, press the Advanced Settings button.

When you do this, three new columns are added: Select by default for, Recommend for and Erase.

Set a clause to be selected automatically
There will usually be some clauses that you always add for every project. You may have some clauses
which you always add for a particular type of scaffold. For example, if a loading bay is in use, you
might add a clause describing responsibility for the foundations.
You can use the Select by default for options to tell SMART Estimator Quote IT when to select a clause
for you automatically.

For future projects:
 If the Project Terms and Conditions option is selected, this condition will be automatically
selected and shown in the Terms and Conditions SMARTText.
 If a scaffold type is selected, this clause will be automatically selected and shown in the
Clauses SMARTText, for items which include the selected scaffold type.
For example, if Independents is selected, this clause will be shown automatically for any item
which includes independent scaffolds.
 If Manual is selected, this clause will be automatically selected and shown in the Clauses
SMARTText, for items which include manual scaffolds and also for empty items.
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Set clause recommendations
Some clauses are not useful for every project, but should be considered every time. For example, if
you have a clause related to winter designs, you would only want to include this for scaffolds which
will be in place over the winter period.
You can use the Recommended for options to tell SMART Estimator Quote IT when to recommend a
clause, rather than automatically selecting it for you.

For future projects:
 If the Project Terms and Conditions option is selected, this condition will appear when the
Recommended Conditions view is shown on the Terms and Conditions SMARTText.
 If a scaffold type is selected, this clause appears when the Recommended Clauses view is
shown on the Clauses SMARTText, for items which include the selected scaffold type.
For example, if Independents is selected, this clause appears when the Recommended
Clauses view is shown on the Clauses SMARTText for any item which includes independent
scaffolds.
 If Manual is selected, this clause appears when the Recommended Clauses view is shown on
the Clauses SMARTText, for items which include manual scaffolds and also for empty items.
For details on how to show the Recommended Clauses and Recommended Conditions views, please
see the Change the clauses view section above.

Erase a clause
To remove a clause from the list, select the X button in the Erase column for that clause.

Save changes to the clauses
You can save your changes to the clause names, description and advanced settings (see above) by
pressing the Save these Settings to All Templates button. If you have changed the clauses selected
for this quotation, choose the Accept and Close button as well:
Save these changes to All Templates stores the text changes to individual clauses.
Accept and Close applies the clauses you selected.

If you don’t save these changes, the advanced settings will not be used for future projects.
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Check your spelling
SMART Estimator will automatically check your spelling against a UK English dictionary. Many
scaffolding system names and common scaffolding terms are already included in this dictionary.
To manually check your spelling, select the text you want to check, then Click on the Spelling button
on the Review Tab of the Text Editing Toolbar.

If there are no errors, a message will appear:

Otherwise, a spell checker will appear:

To add a word to your dictionary, so it is no longer highlighted as an error, click Add to Dictionary.
Note that this will only add the word for you. Any of your colleagues that use the same SMART
Estimator Server as you will not be affected.
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Address books
There are four types of addresses within Quote IT. The customer address, the site address, your own
address and the address of your yard.

Customer addresses
To add a customer you can simply select the Open Address Book button.

And then to add an address select the Add Address button.

You now get a new contact card to fill in.
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Fill in the missing blanks for the customer.

When you select the contact, you have the option to fill in multiple names.

From here you can also set which one you would prefer to be the default contact.
Once you have completed this, select the Close button.
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To add a customer address to your letter, select the address SMARTText: “[Customer Address]” in your
covering letter.

You now have an option to either fill in a new address card and save it, or you can select a customer
name from the Customer Address Book. If you create a customer specific address, you will only be able
to view it by selecting the Select from customer address book button.
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This opens up your address book as before. Now select the customer you want to use.

Close the address book by pressing Select Address.
Select the green tick in the top right to accept your changes.

You will see this has now filled in your address on the letter, and added your contact information.
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Save a site address
This time we will save a site address by filling in the pop-up card for it.
Click on the [Site Address] SMARTText in the quote.
The pop-up card appears.

Type in the details of the site address. Then select the Save New Site button.
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You will be asked whether you want to save this as a new site record. Answer “Yes”.

This is now saved as a site specific address. Now pick the green tick at the top right of the dialog box.

This completes the section on adding customer and site addresses to the address book.
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Edit the lead-in descriptions
A short description can be added to every item. These can be selected from Quote IT, but it is
recommended that Scheduling is used for selecting a lead-in for each item. These “lead-in”
descriptions are usually used for a small introductory paragraph briefly explaining what type of
scaffolding will be included in the item.
You can use the lead-in description for any description you like.
To edit the lead –in description, click on it.

An empty lead-in description

A sample filled in lead-in description

A box will appear with some tools:

Select a clause from the Select column to choose it for this item.
You can change the name from the Name column. This name does not appear in the quote, but is
used to quickly find lead-ins from Scheduling. Lead-ins are sorted by name in Scheduling, so adding a
number at the start of the lead-in is a good way to set the position it will appear in the schedule list.
Change the lead-in text from the Lead-In Description column. Note that you should choose a font to
match the quotation.
Remove lead-ins with the Erase button.
Finally, you can add new lead-in descriptions by pressing the Add Description button.
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SMARTText descriptions
This section contains a description of the SMARTText fields currently available in SMART Estimator.

Project SMARTText
General
Menu Name

Display Name

Description

Contract Number

<<ContractNo>>

The contract number defined in the Project
Browser.

Contract Description

<<ContractDescription>>

Total Items (including
multipliers)

<<NoItemsInContract>>

Total Items in Project
Box
Today’s Date

<<NoSeparateItemsInContract>>

Start Date
Creation Date
My Signature
My Job Title
Terms and Conditions

<<StartDate>>
<<CreationDate>>
<<MySignature>>
<<MyJobTitle>>
<<TermsAndConditions>>

Item Summary table

<<ContractItemSummaryTable>>

The contract description defined in the Project
Browser.
The total number of items in the Project
Browser, multiplied by their respective
Quantities.
The total number of items in the Project
Browser.
Today’s Date. This changes whenever the
quote is opened.
The date work is expected to commence.
The date the quote was first saved.
Your signature graphic.
Your job title.
A list of conditions, usually added at the end of
the quotation.
A table of all items in the project, together with
their price and hire period.

<<TodaysDate>>

Pricing
Menu Name

Display Name

Description

Total Extra Hire
Longest Hire
Period
Highest Material
Supply Rate
Total Labour Cost
Total Material Cost
Total Labour
Overhead
Total Material
Overhead
Total Profit
Total Discount

<<ContractTotalExtraHire>>
<<ContractLongestHirePeriod>>

Total additional hire for the project.

<<ContractHighestMaterialSupplyRate>>

The largest hire period for any item.

<<ContractTotalLabourCost>>
<<ContractTotalMaterialCost>>
<<ContractTotalLabourOverhead>>

The highest % supply rate for materials of
any item.
Total labour cost for the project.
Total material cost for the project.
Total labour overhead for the project.

<<ContractTotalMaterialOverhead>>

Total material overhead for the project.

<<ContractTotalProfit>>
<<ContractTotalDiscount>>

Total profit for the project.
Total discount (not including Main
Contractor Discount) for the project.
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Pre-MCD Total
Tendered Price

<<ContractPreMCDTotalTenderedPrice>>

Highest MCD %

<<ContractHighestMCDPercentage>>

Highest Quantity
Pre-Tax Total
Tendered Price
Total Tax
Total Tendered
Price
Rate Set Used

<<HighestItemQuantity>>
<<ContractPreTaxTenderedPrice>>

Tax Text

<<TaxText>>

Pre-Tax Unit Total
Tendered Price
Day Work (per
person per hour)

<<ContractPreTaxUnitTenderedPrice>>

<<TotalTax>>
<<ContractTenderedPrice>>
<<ContractRateSet>>

<<DayWorkRate>>

The total tendered price for the project
before the Main Contractor Discount is
taken off.
The highest Main Contractor Discount
percentage used by any item.
The highest Quantity used by any item.
The total tendered price for the project
before tax.
The total tax for the project.
The total tendered price for the project.
The name of the pricing rates used for
this project.
Either “All prices exclude tax.” or “All
prices include tax.”
The tax name is taken from the pricing.
The total tendered price for one of each
item in the project (before tax).
The rate for Day Work, as set in Price IT
via the Labour Options menu.

Addresses
Menu Name

Display Name

Description

Postcode (check IT)

<<CheckScaffoldPostCode>>

The post / zip code used to calculate the TG20
check’s wind factor.

Customer Address

<<CustomerAddress>>

Site Address
Depot (Yard) Address
My Address
Customer Name
Site Name
My Name
Customer Contact
Name
Site Contact Name

<<SiteAddress>>
<<DepotAddress>>
<<MyAddress>>
<<CustomerName>>
<<SiteName>>
<<MyName>>
<<CustomerContactName>>

My Contact Name

<<MyContactName>>

Customer Telephone

<<CustomerTelephone>>

Site Telephone
My Telephone
Customer Fax
Site Fax
My Fax
Customer Email
Site Email
My Email
Customer Contact
Title

<<SiteTelephone>>
<<MyTelephone>>
<<CustomerFax>>
<<SiteFax>>
<<MyFax>>
<<CustomerEmail>>
<<SiteEmail>>
<<MyEmail>>
<<CustomerContactTitle>>

<<SiteContactName>>
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The customer’s address.
The site’s address.
The address of your scaffold yard.
Your company address.
The customer’s (company) name.
The site’s name.
Your company name.
The customer’s selected contact name,
including their title, forename and surname.
The site’s selected contact name, including their
title, forename and surname.
Your selected contact name, including the title,
forename and surname.
The customer’s selected contact telephone
number.
The site’s selected contact telephone number.
Your selected contact telephone number.
The customer’s selected contact fax number.
The site’s selected contact fax number.
Your selected contact fax number.
The customer’s selected contact email address.
The site’s selected contact email address.
Your selected contact email address.
The customer’s selected contact’s title, such as
“Mr”.
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Site Contact Title
My Contact Title
Customer Contact
Forename
Site Contact
Forename
My Contact
Forename
Customer Contact
Surname
Site Contact Surname

<<SiteContactTitle>>
<<MyContactTitle>>
<<CustomerContactForename>>

My Contact Surname

<<MyContactSurname>>

<<SiteContactForename>>
<<MyContactForename>>
<<CustomerContactSurname>>
<<SiteContactSurname>>

The site’s selected contact’s title, such as “Mr”.
Your selected contact’s title, such as “Mr”.
The customer’s selected contact’s forename,
such as “John”.
The site’s selected contact’s forename, such as
“John”.
Your selected contact’s forename, such as
“John”.
The customer’s selected contact’s surname,
such as “Smith”.
The site’s selected contact’s surname, such as
“Smith”.
Your selected contact’s surname, such as
“Smith”.

Item SMARTText
General
Menu Name

Display Name

Description

Name
Number

<<ItemName>>
<<ItemNo>>

The item’s name.

Number of Scaffolds
Systems

<<NoScaffoldsInItem>>
<<Systems>>

Clauses

<<Clauses>>

The position of the item in the Project Browser.
The number of separate scaffolds in the item.
A list of all the scaffolding systems used in the
item.
A list of clauses specific to this item.

Pricing
Menu Name

Display Name

Description

Quantity
Hire Period

<<ItemName>>
<<ItemNo>>

The item’s name.

Labour Total

<<NoScaffoldsInItem>>

Output Pay Total

<<Systems>>

Erect Total

<<ErectScaffoldTotal>>

Dismantle Total

<<DismantleScaffoldTotal>>

Adaptions Total

<<AdaptionsTotal>>

General Labour
Total

<<GeneralLabourTotal>>
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The position of the item in the Project
Browser.
The number of separate scaffolds in the
item.
A list of all the scaffolding systems used in
the item.
The total cost to erect all of the
scaffolding in the item.
The total cost to dismantle all of the
scaffolding in the item.
The total cost to adapt all of the
scaffolding in the item.
The item’s general labour.
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Additional Costs
Total

<<AdditionalCostsTotal>>

Expenses Total

<<LabourExpensesTotal>>

Wage On-Costs
Total
Materials Total
Material Hire for
100% Supply
Material Supply %
Material Hire Total
Contract Expenses
Total

<<WageOnCostsTotal>>

The item’s additional labour cost
(including travel expenses, wage-on costs,
etc.)
The item’s additional labour expenses
(including travel expenses, labour
downtime, etc.)
The item’s labour wage-on costs.

<<MaterialsTotal>>
<<Material100PercentageSupplyTotal>>
<<MaterialSupplyPercentage>>
<<MaterialHireTotal>>
<<ContractExpensesTotal>>

The item’s total material cost.
The item’s total material cost if 100% of
materials were supplied.
The % of materials which will be supplied.
The item’s total material hire cost.
The item’s material contract expenses
(including hire expenses, sale expenses
and transport).
The item’s total material purchase cost.

Material Purchase
Total
Other Costs Total
Direct Costs Total

<<MaterialPurchaseTotal>>

Overheads Total
Labour Overhead
Total
Material Overhead
Total
Costs Total

<<OverheadsTotal>>
<<LabourOverhead>>

The item’s other costs total.
The item’s total direct costs (labour +
materials).
The item’s total overheads.
The item’s total labour overhead.

<<MaterialOverhead>>

The item’s total material overhead.

<<TotalCosts>>

The item’s total cost (labour, materials,
other costs and overheads).
The item’s total margin.
The item’s total profit (not including
discount).
The profit made by selling materials in
this item.
The item’s total profit margin.
The item’s total discount (not Main
Contractor Discount).
The tendered price for one of this item
before tax.
The tendered price for this item before
tax.
The tendered price for this item before
Main Contractor Discount is applied.
Main Contractor Discount percentage.

<<OtherCostsTotal>>
<<DirectCostsTotal>>

Margins Total
Profit Total

<<MarginsTotal>>
<<ProfitTotal>>

Material Mark-Up
Total
Profit Margin Total
Discount Total

<<MaterialMarkUp>>

Pre-Tax Unit
Tendered Price
Pre-Tax Tendered
Price
Pre-MCD Tendered
Price
Main Contractor
Discount (MCD) %
Main Contractor
Discount (MCD)
Total
Tax %
Tax Total
Total Tendered
Price
Unit Extra Hire

<<PreTaxUnitTenderedPrice>>

<<ProfitMargin>>
<<Discount>>

<<PreTaxTenderedPrice>>
<<PreMCDTenderedPrice>>
<<MainContractorDiscountPercentage>>
<<MainContractorDiscount>>

The value of the Main Contractor
Discount.

<<TaxPercentage>>
<<Tax>>
<<TenderedPrice>>

The % value applied for tax.
The value of tax.
The item’s total tendered price.

<<UnitExtraHire>>

The item’s total additional hire for a
quantity of one.
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Total Extra Hire

<<TotalExtraHire>>

The item’s total additional hire including
the item quantity.

Description
Menu Name

Display Name

Description

Physically Tied
Description
Progressive
Description

<<IsPhysicallyTied>>

“Physically tied” if any scaffold in the item is tied
to a façade. Otherwise blank.
If a discount for progressive erection and
dismantling has been applied, this shows a
sentence which describes this.
Whether the scaffolding will be adapted or not.
A list of all the add-ons, such as bridges, present in
the item.
A table of all scaffolds and scaffolded elevations in
the item, together with their dimensions.
The maximum and most common lift height in the
item.
A description of the guardrails.

<<ProgressiveDescription>>

Adaption Description
Add-ons Description

<<AdaptionDescription>>
<<AddOnsDescription>>

Scaffold Dimensions

<<ScaffoldDimensions>>

Lift Heights
Description
Guardrails
Description
Decking Title

<<LiftHeightDescription>>
<<GuardrailsDescription>>
<<DeckingTitle>>

Decks Description
Toe Boards
Description
Access Title

<<DecksDescription>>
<<ToeBoardsDescription>>

Access Description

<<AccessDescription>>

Loading Title

<<LoadingTitle>>

Loading Description

<<LoadingDescription>>

Scaffolding Type

<<ScaffoldingType>>

Item Usage
Description
Maximum Nominal
Grid
Scaffold Width

<<ItemUsageDescription>>
<<MaximumNominalGrid>>

Lead-In Description

<<LeadInDescription>>

<<AccessTitle>>

<<ScaffoldWidth>>
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The word “Decking” for use as a title.
This is hidden if there are no scaffolds with decking
descriptions in this item.
Lists the board / deck material used in the item.
Lists the toe boards used in the item.
The word “Access” for use as a title.
This is hidden if there are no scaffolds with access
descriptions in this item.
Describes ladders, ladder towers and stairs present
in the item.
The word “Loading” for use as a title.
This is hidden if there are no scaffolds with loading
descriptions in this item.
Describes the loads applied to the scaffold. You
will need Check IT TG20:13 to choose these loads.
If only one type of scaffold is present, this shows
the scaffold type. Otherwise, this shows
“scaffolding”.
Sometimes known as a ‘lead-in’. The purpose the
item will be used for.
The largest nominal grid size for loading the
scaffolding.
The width of the scaffold, including inside boards
and cantilever ‘hop-up’ platforms.
An optional pre-defined description introducing
the item. Lead-ins can be customised (see the Edit
the lead-in descriptions section).
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Using the other SMART Estimator products
The best way to use the SMART Estimator products is to use them together. Every product is designed
to enhance the rest of the suite.
SMART Estimator Quote IT can be used with the rest of the SMART Estimator products:

Model IT
SMART Estimator Model IT is a powerful 3D modelling tool. Use it to create scaffolds to exactly meet
your project-specific needs. You can set details about these scaffolds such as their names, the
scaffolding systems being used and their dimensions. These details can all be used in the quotations.

Schedule IT
SMART Estimator Schedule IT can be used in a similar way to Model IT. It can be used to rapidly create
large multi-scaffold projects. All of the dimensions and names will appear in the quotations.

Check IT TG20:13
Set useful information such as the loading on the scaffolds, which can be used in the quotations. Also
check your scaffolding for TG20:13 compliance.

Report IT
Check, customise and print material lists and technical drawings for your project, which can be sent
along with the quotations.

Price IT
Produce highly customisable pricing reports as well as reusing the pricing information in the
quotations.

BIM Toolbox
Create scaffolds more quickly, using information from an existing model, or export data from SMART
Estimator to be used in other design software.

For more information about the other SMART Estimator products, please refer to
their user guides, which are available from the Help tab.
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Feedback
Thank you for choosing SMART Estimator.
We are always striving to improve the product so please contact us with your feedback. We are always
keen to hear new ideas and if you experience any problems with the software we want to hear about
them so that they can be resolved.

You can contact us via:
 Our website support centre at www.smartscaffolder.com/support.html;
 Email on support@smartscaffolder.com;
 Telephone on +44 (0)1202 603733 from Monday to Friday between 09:30 and 17:00.
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